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FROM THE AUTHOR 
Welcome to The Smart Guide To Creating Your Own Fantasy Baseball Rankings.   

Fantasy baseball is fun.  And it’s more fun when you make your own rankings.  There’s a greater sense of strategy, gamesmanship, 
and enjoyment when you create your own rankings specifically tailored to your league’s settings.   

These instructions came about because I have never been comfortable just printing out a set of rankings from a major fantasy website.  I 
don’t want to know how sausage gets made, but I do want to know where my fantasy baseball rankings come from.   

The fact is that everyone’s league is a little different.  10-teams.  12-teams.  5x5.  4x4. Sabermetric categories.  Traditional categories.  
Deep benches.  Shallow benches.  How does each team having three keepers affect rankings?  What if each team keeps six?  And that 
doesn’t even take into account the preferences and tendencies of other managers in my league.  What if my league has historically had 
tightly packed standings in home runs?  What if I want to devalue stolen bases because I think I can acquire them in-season? 

A lot of publicly available ranking systems don’t show the underlying projections.  They’re just cheat sheets or listings of players.  What 
if you think Bryce Harper will hit 35 home runs and the rankings you’re looking at say 28?  Where should Harper move if you expect 35?   

This guide will show you how to plug in your favorite projection system and create your own rankings based upon those projections.  The 
rankings will be dynamic.  You can change the projection for any player and instantly see how they move up or down the rankings.   
And it can all be tailored to your league’s settings and history.   

If you have any suggestions for improvements to this process, please e-mail me at SmartFantasyBaseball@gmail.com.   

I can’t thank you enough for taking the time to follow SFBB.  Speaking of following, click the button below to follow SFBB on Twitter.  
Continue to make smart choices. 

        ~ Tanner Bell  

  

mailto:SmartFantasyBaseball@gmail.com
https://twitter.com/smartfantasybb
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FEATURES 
When you complete this guide, you will be able to: 

• View a complete ranked list of all players at any position 
• Compare the value of a pitcher to a hitter 
• View projections for any fantasy relevant player 
• Update projections for any player and immediately see a revised ranking for the player 
• Easily roll this file forward from year-to-year and plug in updated projection data 

OVERVIEW 
This e-book is derived from a series of articles posted at SmartFantasyBaseball.com before the 2013 MLB season (click here to 
see the original series of posts).  The player names, projections, and screenshots reflect this, but you can follow these exact 
instructions to prepare for the 2014 (or any future) season.   

These instructions demonstrate the process of creating rankings for a traditional rotisserie 12-team mixed league.  But they’ll 
help you develop the skills and methodologies necessary to create rankings for any scenario and any league format. 

These have specifically been written for Microsoft Excel.  I used Excel 2010 while creating this guide, but you should have no 
issue if you’re using Excel 2007 or Excel 2013.  While I don’t have a comprehensive manual specifically for other spreadsheet 
programs, there are some very good free alternatives available.  Things will work best if you are at least somewhat experienced 
working with Excel.  But even if you’re not, I include explanations of all the formulas used.  I’ve tried to write these well 
enough that anyone can follow along.   

IF YOU HAVE QUESTIONS   
Please post your questions or comments about the rankings in the comment section for each Part of the series.  You can access 
the comment areas using these links: 

http://www.smartfantasybaseball.com/create-your-own-rankings/
http://www.smartfantasybaseball.com/create-your-own-rankings/
http://www.smartfantasybaseball.com/2013/09/3-free-alternatives-to-microsoft-excel/
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• Overall 
• Part 1 – Download Free Projection Data 
• Part 2 – Understanding Player IDs 
• Part 3 – VLOOKUP, Excel Tables, Named Ranges 
• Part 4 – Pitcher Rankings 
• Part 5 – Understanding Standings Gain Points 
• Part 6 – Accounting for Replacement Level and Position Scarcity 

 

Now let’s get started!  

http://www.smartfantasybaseball.com/create-your-own-rankings/#comment-149
http://www.smartfantasybaseball.com/2013/03/create-your-own-fantasy-baseball-rankings-part-1-download-free-projection-data/#comment-150
http://www.smartfantasybaseball.com/2013/03/create-your-own-fantasy-baseball-rankings-part-2-understanding-player-ids/#comment-151
http://www.smartfantasybaseball.com/2013/03/create-your-own-fantasy-baseball-rankings-part-3-vlookupseexcel-tables-excel-named-ranges/#comment-155
http://www.smartfantasybaseball.com/2013/03/create-your-own-fantasy-baseball-rankings-part-4-pitcher-rankings/#comment-152
http://www.smartfantasybaseball.com/2013/03/create-your-own-fantasy-baseball-rankings-part-5-understanding-standings-gain-points/#comment-153
http://www.smartfantasybaseball.com/2013/03/create-your-own-fantasy-baseball-rankings-part-6-accounting-for-replacement-level-and-position-scarcity/#comment-154
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PART I – DOWNLOAD FREE PROJECTION DATA 
INTRODUCTION 

Welcome to the first part in a series of posts in which I’ll go through the process I use to create my own fantasy baseball rankings.  At the end 
of each Part you’ll find a link to download the rankings project (in Excel 2010 format) as it stands at the end of that respective Part.  If you 
have questions about Part 1, please post them in the comments here so others may benefit from the answer to your questions. 

In this first part of the series we’ll set up a new Excel file, download free projection data, and do some basic formatting to make the file 
presentable. 

STEP-BY-STEP INSTRUCTIONS 

Step Description 
1.  To start, create and save a new Excel file for this project.  Leave the file open. 

This spreadsheet is going to get fairly large and involve a lot of formulas.  I recommend making periodic backups of your file in case 
anything were to go wrong.   

 

2.  There are a number of outlets where you can pay for projections.  But Fangraphs offers a “Projections” section that includes a number of 
free projection systems for download.   

 

Choose your favorite projection system and use the link to “Export Data”.  For the rest of this e-book I will be using the “Steamer” 
projections. 

http://www.smartfantasybaseball.com/2013/03/create-your-own-fantasy-baseball-rankings-part-1-download-free-projection-data/#comment-150
http://www.fangraphs.com/
http://www.fangraphs.com/projections.aspx?pos=all&stats=bat&type=steamer&team=0&players=0
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3.  The data will download in CSV (comma separated value) format.  Locate the downloaded CSV file and open it.  It should open in 
Microsoft Excel (if it doesn’t, launch Excel and then use the File>Open menu to open the CSV file).  Once the file opens right-click on 
the “Fangraphs Leaderboard” tab and select the option to “Move or Copy…” 

 

When prompted, choose your Rankings Excel file (saved in step 1 above) from the drop down menu.  Then hit “OK”. 
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4.  Any sheet downloaded from Fangraphs has the tab name “FanGraphs Leaderboard”.  Right click on the spreadsheet tab to give it a more 
meaningful name (like Steamer Hitters). 

 

5.  Hitter and pitcher projection data are stored separately on Fangraphs.  Go into the Pitchers section and repeat steps 2 through 4. 

 

6.  Please note that depending upon the time of year, there may be several projection systems available to download:  FANS, ZiPS, Steamer, 
and Oliver, to name a few. 
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I’m going to download the hitter and pitcher projections from all four systems and pull the data into my rankings spreadsheet by 
repeating steps 2 through 5 for each projections system, paying careful attention to name each tab in such a way that I can easily identify 
the source of the data. 

 

7.  In order to maintain organization (the file is already up to eight tabs), I like to add placeholder worksheets to separate the data.  Do this 
by clicking on the small right-most tab, which is a shortcut to insert a blank worksheet.  Click this twice in order to create two new 
worksheets. 

 

Right click on one of the newly created worksheet and choose the option to rename.  Name the sheet “HITTER PROJECTIONS=>”.  
Right click on the other worksheet and rename it to “PITCHER PROJECTIONS=>”.  Then click and drag on these placeholder tabs to 
move them. 

 

Continue dragging and dropping worksheets to get all hitter projections in one section and all pitcher projections in one section. 

 

8.  You’re going to be looking at this spreadsheet for a significant amount of time, so you should spend a minute on the aesthetics.  Right 
click on the tabs and choose the option to add some color to this thing (“Tab Color”). 
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If you’re interested, Smart Fantasy Baseball Blue is custom color 17R, 137G, 183B on the RGB scale. 

 

WRAP UP 

We’ve now got the basic infrastructure for our rankings.  In the next part of the series we’ll discuss player ID numbers, which will lead into 
using Excel functions and tools to allow us to start pulling data from the projection worksheets. 

LINK TO DOWNLOAD EXAMPLE FILE 

 SFBB Rankings – Part 1.xlsx 

QUESTIONS? 

Questions about Part 1?  Post them here. 

WANT TO MAKE YOUR OWN PROJECTIONS? 

If you’re enjoying this series, you may also be interested in learning to develop your own projections.   

 

http://www.smartfantasybaseball.com/wp-content/uploads/2013/03/SFBB-Rankings-Part-1.xlsx
http://www.smartfantasybaseball.com/2013/03/create-your-own-fantasy-baseball-rankings-part-1-download-free-projection-data/#comment-150
http://www.smartfantasybaseball.com/zg3v
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PART 2 – UNDERSTANDING PLAYER IDS 
INTRODUCTION 

In this second part of the series we discuss what player IDs are so we can later use them to pull information within Excel.  You might have 
noticed the projection data downloaded from Fangraphs in part 1 did not contain the player’s team or position.  But the downloads did contain 
each player’s Fangraphs ID.  We can take advantage of this! 

UNDERSTANDING PLAYER IDS 

Are you familiar with Chris Young, the former Arizona Diamondback outfielder with a career batting average of about .240?  Are you 
familiar with Chris Young, the oft-injured extremely tall pitcher with a career ERA of 3.79? 

Even if you’re not familiar with them, know that there are two baseball players of recent note named Chris Young.  Look at this chart: 

Source .240 Hitting OF Tall Injured SP 

Name Chris B. Young Chris R. Young 

Baseball Reference youngch04 youngch03 

Fangraphs 3882 3196 

MLB 455759 432934 

CBS 4898811 517762 

Just like you have a unique Social Security Number or employee ID associated with your name, baseball players have been given unique IDs 
from different organizations/websites.  These IDs give us a way to differentiate Chris B. Young from Chris R. Young.  The problem is that 
there is not an agreed upon ID for each player.  Each website or fantasy service uses their own ID. 

We need a tool to translate the different player IDs from the various baseball services.  That’s where the Smart Fantasy Baseball Player ID 
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Map comes in. 

PLAYER ID MAP 

The SFBB Player ID Map contains the Fangraphs, MLB, Baseball-Reference, Retrosheet, CBS, and NFBC player ID for over one thousand 
players.  It’s not a comprehensive list of past players by any means, but it should have all current MLB players and those minor league 
players likely to make a fantasy impact this season.   

 

To give credit where credit is due, I downloaded the player map from Crunchtimebaseball.com and tailored it to meet my needs.  This 
provided me with an excellent starting point. 

On this site I will typically work with the Baseball Reference ID format.  I like working with that format more than the others because I can 
look at an ID and usually determine who the player is (troutmi01 is Mike Trout).  Whereas most other sites use a straight ID number that has 
no inherent meaning (Trout’s Fangraphs ID is 10155).   

STEP-BY-STEP INSTRUCTIONS 

These instructions will take us through the process to pull the SFBB Player ID Map into our rankings spreadsheet. 

Step Description 
1.  Open your existing rankings spreadsheet (if you don’t have one started, you can download one from part 1 here). 

2.  Download and open the SFBB Player ID Map. 

3.  After you have opened the SFBB Player ID Map, right-click on the “PLAYERIDMAP” tab and select the “Move or Copy…” option. 

http://www.smartfantasybaseball.com/wp-content/uploads/2013/03/SFBB-Player-ID-Map.xlsx
http://www.crunchtimebaseball.com/
http://www.smartfantasybaseball.com/wp-content/uploads/2013/03/SFBB-Rankings-Part-1.xlsx
http://www.smartfantasybaseball.com/wp-content/uploads/2013/03/SFBB-Player-ID-Map.xlsx
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4.  In the “Move or Copy” menu, select your rankings spreadsheet in the “To book:” drop down menu (we’re copying the Player ID Map 
into the Rankings file, or whatever you named your spreadsheet in Part 1). 
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5.  Choose to put the Player ID Map before the “Hitter Projections=>” worksheet.  Hit OK. 

 

6.  You now have a spreadsheet sheet with projections from several different sources as well as the Player ID Map. 

 

WHAT CAN WE DO WITH THIS?  I NEED AN EXAMPLE 

As I mentioned above, I prefer to use the Baseball Reference player ID format.  But the projection data uses Fangraphs’ IDs.  The Player ID 
Map can “convert” the Baseball Reference ID to a Fangraphs ID. 

Let’s use Miguel Cabrera (player ID “cabremi01″) as an example.  We can instruct Excel to go to into the Player ID Map and find 
“cabremi01″.  Then translate that into Cabrera’s Fangraphs ID (Cabrera’s is “1744″).  Then take that “1744″, go to the projections, find 
“1744″, and then pull Cabrera’s projected home runs elsewhere in the spreadsheet.   
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It’s difficult to explain in words.  The diagram below might help.  Follow the red arrows. 

 

WRAP UP 

In the next part of the series we’ll start to pull player data (name, position, team, projected stats) as depicted in the diagram above. 

If this is intimidating, don’t worry.  You can do this. 

LINK TO DOWNLOAD EXAMPLE FILE   

SFBB Rankings – Part 2.xlsx 

http://www.smartfantasybaseball.com/wp-content/uploads/2013/03/SFBB-Rankings-Part-2.xlsx
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QUESTIONS? 

Questions about Part 2?  Post them here. 

PART 3 – VLOOKUP, EXCEL TABLES, AND NAMED RANGES 
INTRODUCTION 

In this third part of the series we will use Excel formulas and functions to start pulling player information (name, position, team) and 
projection information in order to eventually calculate our own rankings.  Strap in…  This is a long one. 

EXCEL FUNCTIONS AND FORMULAS IN THIS POST 

Below are the Excel functions and formulas used in this part of the series.  If you’re already familiar with what these are, you can skip ahead.   

VLOOKUP 

This is one of the most powerful Excel formulas.  And it’s easier to use than you might think.  This formula searches the first column of a 
table for a desired value (a player ID) and then returns a value that is in the same row but in a separate column.  For example, we might tell 
Excel to go into a table of projection data, locate a specific player ID (like “cabremi01”, Miguel Cabrera), and give us back the number in the 
eighth column (which holds the number of HRs). 

This formula requires four inputs: 

VLOOKUP(lookup_value, table_array, col_index_num, range_lookup) 

1. lookup_value – This is the value to search for.  In the rankings spreadsheet, we’re mostly going to use player IDs for this.  ”Hey 
Excel, go look for this player ID”. 

2. table_array – This has to be two or more columns of data.  Excel will look for the look_up value in the first column in the set of 
data.  You do not necessarily need to include the first column on a spreadsheet tab.  But Excel is going to look through the first 
column you provide.  ”Hey Excel, here are ten columns of data for you, look through everything in the first column for the 

http://www.smartfantasybaseball.com/2013/03/create-your-own-fantasy-baseball-rankings-part-2-understanding-player-ids/#comment-151
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lookup_value.” 

3. col_index_num – This is the column number from the table_array that contains your desired information.  This has to be a number 
and it has to be within the table_array you provided.  For example, if your table_array only has five columns, but you put a 6 for 
col_index_num, you’ll have a problem.  ”Hey Excel, the eighth column has projected home runs.    Tell me how many home runs 
are projected for this player ID.” 

4. range_lookup – This input can be either “TRUE” or “FALSE”.  If you use “TRUE”, Excel will look for an approximate match of 
the lookup_value (PLAYERID).  If you enter “FALSE”, Excel will only look for an exact match.  This is an optional input, but I 
feel very strongly that it must be used and that “FALSE” is the option to be selected.  You may otherwise get the wrong 
projections showing up for players. 

TABLES (NAMED RANGES) 

Excel has functionality that allows you to convert a block of data (player projections) into a table.  There are quite a few benefits to using 
tables: 

1. Tables can have names.  This is great for the table_array input in the VLOOKUP formula.  We can give the projection sheet the name 
“STEAMER_H” (for Steamer Hitters projections) and use that instead of traditional way of selecting data in Excel (something like 
’Steamer Hitters’!A1:W500). 

2. Columns have names.  I have a hard time remembering what column projected HR is in.  But I don’t need to if I know that the column 
name is “HR”.  If you don’t use a table, you’re stuck trying to remember things like, “were HRs in column G, H, or I?”.  When 
referring to a column, use the following convention – TABLENAME[COLUMNNAME].  The column name is surrounded in 
brackets. 

3. Easily adding calculations.  In a table, all formulas within a column are identical.  This is great for consistency.  And because of this, 
when you change the formula in one cell of a column, the rest of the column automatically updates too.  No more editing a formula in 
one cell and having to copy it to hundreds of other cells. 

4. Easy sorting and filtering.  As easy as clicking a drop down arrow. 
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COLUMN 

This function returns the column number of a cell or range of data.  The function only requires one input; the cell or range to be evaluated.  
For example: 

COLUMN(TableName[ColumnName]) the input is a column name from a table and the formula will return the column number. 

STEP-BY-STEP INSTRUCTIONS 

Step Description 
1.  In Part 1 of this series we look at how easy it is to find some high quality projection data for free.  For the sake of simplicity, I’m going 

to pick one source to move forward with.  This smart article at Razzball reviews the accuracy of 2012 projections and puts the Steamer 
projections in a positive light.  So I’m going to move forward and base my rankings off of Steamer.  You can choose whatever source 
you prefer. 

2.  To make the projections easier to work with, convert the “Steamer Hitters” tab to a “table” in Excel.  Click anywhere within the data on 
your hitter projection worksheet.  Then locate the “Home” tab in the Excel menu system (“the ribbon”).  Click once on the “Format as 
Table” drop down, and then select your desired color scheme. 

 

 

 

 

http://razzball.com/fantasy-baseball-projections-review-2012/
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You will then be prompted to verify the range of cells in the table and that your table has a header row (e.g. Name, AB, H, HR, etc.).  
Check “My table has headers”.  Click OK. 

 

After accepting this, your bland looking data will transform into a table. 

3.  We’ll later be pulling information from this table into other worksheets.  To make the pulling of data easier we need to move the 
Fangraphs player ID to be the first column (you can use VLOOKUP if the player ID is in the first column, otherwise you’re stuck using 
more difficult and/or multiple formulas).  Right-click on the top of the Fangraphs player ID column (I right clicked on the “AB” column 
header, not for At Bats, as in the column next to column “AA”) and Cut it. 

 

4.  Now right-click on the top of the player name column (column header “A”) and select “Insert Cut Cells”. 



The Smart Guide To Creating Your Own Fantasy Baseball Rankings    Tanner Bell 

Page 18  
  

 

5.  Before we finalize this table, we must give it a name.  Go to the “Formulas” tab on the Excel ribbon and click on the “Name Manager” 
button. 

 

6.  Excel will give very generic names to a table, like “Table2″.  It’s more helpful to give meaningful names to your tables.  As you get more 
tables in a spreadsheet, it can become very difficult to remember the difference between “Table2″ and “Table3″.  Note how there is 
already a table named “PLAYERIDMAP”.  I previously set up this table before you inserted it into your Excel file in Part 2 of this series.   

Select your table from the list and click on the “Edit…” button. 
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7.  Give the table a meaningful name.  I chose “STEAMER_H” to indicate these are the Steamer Hitter projections.  Click “OK” to close the 
“Edit Name” menu.  Then click “Close” to exit the “Name Manager”. 

 

8.  We now have two tables ready to pull information from, PLAYERIDMAP and STEAMER_H.  I’m going to pull from these two tables 
into a new tab where I’ll calculate the hitter rankings. 

9.  Right click on the “PLAYERIDMAP” tab and select the option to “Insert…”.  Choose the “Worksheet” option and click “OK”.   
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10.  Right click on the new sheet tab and choose to “Rename”.  I’ll call this sheet “Hitter Ranks”. 

 

11.  I want the first column of this new sheet to contain the Baseball Reference player ID (e.g. cabremi01).  I believe the PLAYERIDMAP 
sheet has a list of all fantasy-relevant players (for standard rotisserie leagues, at least).  However, this sheet contains pitchers also.  
Because this sheet is an Excel table, it’s easy to filter out those pitchers.  Click on the drop down arrow on the “POS” column.  You’ll be 
presented with a list of all the positions.  Uncheck any “RP”, “SP”, “P” values.  Click OK to apply. 
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12.  Starting at the first player and ending with the last, click and drag within the “IDPLAYER” column (first column) and select all players.  
Only select from this first column. 

 

13.  Copy this selected data.   Return to the “Hitter Ranks” sheet.  Type “PLAYERID” into cell A1 (to label the column).  Then paste the data 
into cell A2. 
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14.  Now that we’re starting this new sheet, we should convert it to an Excel table.  We will essentially repeat step 2 above, but for this 
different worksheet.  Click once to select any player ID.  Then locate the “Home” tab in the Excel menu system (“the ribbon”).  Click 
once on the “Format as Table” drop down, and then select your desired color scheme. 

 

15.  You will then be prompted to verify the range of cells in the table and that your table has a header row (which we added in step 13).  
Check “My table has headers”.  Click OK. 

 

16.  Repeat steps 5-7 in order to give the table a more meaningful name.  In my example, Excel defaulted the table name to “Table3″.  I 
renamed mine to be “MYRANKS_H” (to indicate hitter ranks, because we’ll also be ranking pitchers). 
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17.  Now for the fun part…  pulling data from the other tabs.  I’ll first add “Player Last Name” to the table.  To expand your table, simply 
type into column B and hit Enter (I typed into cell B1).  Excel should automatically pull this new column into your table.  I’m going to 
name my column “LNAME”. 

 

18.  Our goal in this column is to instruct Excel to take the PLAYERID from column A, go into the first column of PLAYERIDMAP, find 
the matching PLAYERID, and then pull the corresponding LASTNAME.  You can see in the image of the PLAYERIDMAP below that 
LASTNAME is in the fourth column (column D). 

 

To start building the formula, click in cell B2 of your Hitter Ranks tab.  Then click the “fx” button of the formula bar to launch Excel’s 
formula wizard.  We’ll use the wizard the first time through to better explain this function in Excel. 
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19.  Type “vlookup” into the search bar and click “Go”.  When the function appears, make sure it is selected and hit “OK”. 

 

You should then see the different arguments, or components, needed for the formula to work. 
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20.  The “Lookup_value” is the value on the “Hitter Ranks” sheet that we want to locate in “PLAYERIDMAP”.  Click once in the 
“Lookup_value” field, just to place the cursor.  Then click on the value in cell A2 (“abreubo01″ in my example).  Excel will convert this 
to [@PLAYERID].  This naming convention can be used when you have converted your data into an Excel table.  If you can’t remember 
the naming convention, you can always use this formula wizard to build formulas. 

 

21.  The “Table_array” field is the table in which to go look for the matching PLAYERID.  Click once in the “Table_array” field.  Simply 
type “PLAYERIDMAP” (no quotes).  Again, this is another benefit of using Excel tables.  It’s much easier to type in the table name than 
it is to flip tabs in Excel and select a giant range of data. 
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22.  The “Col_index_num” field wants to know the number of the column in the PLAYERID map table to retrieve data from.  Again, our 
goal is to retrieve LASTNAME from the PLAYERIDMAP table, which is column 4.   You could manually flip back and forth between 
tabs to determine the column number.  You could then enter a 4 in for “Col_index_num”.  For now entering a 4 seems like the easy thing 
to do.  But this strategy takes time and is difficult to manage when you start getting into column X (do you know what number letter of 
the alphabet that is?).  Alternatively, I prefer to use the COLUMN function.  When the COLUMN formula  is entered into the 
Col_index_num field, it will return the column number.  The formula below will determine that LASTNAME is the fourth column in the 
PLAYERIDMAP table. 

COLUMN(PLAYERIDMAP[LASTNAME]) 

Enter this equation into the Col_index_num field. 
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23.  Finally, we have the Range_lookup argument.  I always enter “FALSE” for this in order to ensure Excel only locates exact matches for a 
PLAYERID.  I don’t want Excel to return an approximate match if the exact PLAYERID cannot be found (Excel might think Melky 
Cabrera is a close enough match to Miguel Cabrera and start feeding through projections for Melky instead of Miggy). 
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24.  Before hitting “OK” to accept the formula, you can preview the output.  In this case we are dealing with “abreubo01″, or Bobby Abreu, 
and can see the formula appears to be working, giving us the last name “Abreu”.  Click OK to accept the formula. 

 

25.  Once the formula is entered, it should automatically copy to the remaining rows of the table. 

 

26.  We will use the VLOOKUP formula to pull additional data, and the majority of the formula will remain the same.  To add a FNAME 
column, type the column name into cell C1.  Copy the formula from cell B2 (actually copy it from the formula editor bar like shown in 
the image below, then hit ESC to exit the formula editor). 
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Paste the formula into cell C2.  Then simply change the column name (remember column names are surrounded in [brackets].  So change 
[LASTNAME] to [FIRSTNAME].  Hit Enter and you will see all the first names pull in. 

 

27.  Repeat step 26 to pull TEAM, POS, and IDFANGRAPHS from the PLAYERIDMAP tab. 

 

If you can’t remember the exact name of a column, once you have entered a table name, like PLAYERIDMAP, and the opening “[" 
bracket, a helpful type ahead box will display all the column names in the PLAYERIDMAP table.  At that point you can finish typing the 
column name or select the desired column name with your mouse. 
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28.  We've now pulled all the relevant information from PLAYERIDMAP and can now begin pulling in hitter projections.  We have to add 
columns and VLOOKUP formulas to pull plate appearances (PA), at bats (AB), hits (H), home runs (HR), runs (R), runs batted in (RBI), 
walks (BB), strikeouts (SO), and stolen bases (SB).   

There will be some tweaks to the VLOOKUP formula we used earlier.  First, the Steamer projections use Fangraphs ID numbers.  So we 
will be using the IDFANGRAPHS column as the Lookup_value.  Second, we must specify to pull from the Steamer Hitters projections 
(STEAMER_H table name).  And finally, the COLUMN formula will change to determine what statistic to pull. 

=VLOOKUP([@IDFRANGRAPHS],STEAMER_H,COLUMN(STEAMER_H[PA]),FALSE) 

The example formula above is for plate appearances (“[PA]”).  Go through and add columns to also pull in “[AB]”, “[H]”, “[HR]”, 
“[R]”, “[RBI]”, “[BB]”, “[SO]”, and “[SB]”. 

29.  I don’t pull average or any other rate statistics (OBP, SLG, etc.).  I prefer to recalculate them with a formula after the underlying 
statistics have been pulled.   

For example, if I disagree with a projection and think a player will not have 500 ABS, he’ll only have 400.  And he won’t have 125 hits, 
he’ll only have 90.  My changes indicate a different batting average.  So it makes more sense to calculate batting average via a formula, 
so these updated projections are captured and a new batting average will automatically calculate.   

To do this, type “AVG” in as a column header.  Then enter the formula “=[@H]/[@AB]” to calculate batting average  

 

30.  Most statistics don’t need formatting, but AVG will.  Click on the “P” column header to select the entire AVG column. 
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Then on the Home tab of the ribbon, click on the comma number format. 

 

Finally, click on the symbol to increase the decimal places from 2 to 3. 
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31.  We’ve now successfully combined player information and projected stats into one table. 

 

WRAP UP 

This was a long one…  Stick with it.  What we just set up is extremely powerful.  Our rankings tab is now linked to the projection tab.  In the 
future you will be able to edit all of the projections on the projection tab and instantly have updated player rankings.   

And even more powerful, when next season rolls around you will be able to just plug new projections into this file and instantly have updated 
rankings for the upcoming season.  You don’t need to redo these things every year!   

In the next part of the series we’ll reperform many of these same steps in order to create a pitchers rankings table.  It will be a more 
abbreviated post that will only touch on the key differences needed for pitchers. 

LINK TO DOWNLOAD EXAMPLE FILE 

SFBB Rankings – Part 3.xlsx 

QUESTIONS? 

Questions about Part 3?  Post them here. 

 

http://www.smartfantasybaseball.com/wp-content/uploads/2013/03/SFBB-Rankings-Part-3.xlsx
http://www.smartfantasybaseball.com/2013/03/create-your-own-fantasy-baseball-rankings-part-3-vlookupseexcel-tables-excel-named-ranges/#comment-155
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PART 4 – PITCHER RANKINGS 
INTRODUCTION 

In this fourth part of the series we will use Excel formulas and functions to start pulling pitcher information (name, position, team) and 
projection information in order to eventually calculate our own rankings.  This post assumes you are familiar with the Excel functions and 
formulas used in Part 3. 

EXCEL FUNCTIONS AND FORMULAS IN THIS PART 

Below are the Excel functions and formulas used in this post.  If you would like more background on them, please refer to Part 3. 

• VLOOKUP 

• TABLES and NAMED RANGES 

• COLUMN 

STEP-BY-STEP INSTRUCTIONS 

Step Description 
1.  Staying consistent with the hitting projections, I’m going to use the free Steamer projections from Fangraphs. 

2.  To make the pitching projections easier to work with, convert the “Steamer Pitchers” tab to a “table” in Excel.  To do this, click 
anywhere within the data on the “Steamer Pitchers” worksheet.  Then locate the “Home” tab in the Excel menu system (“the ribbon”).  
Click once on the “Format as Table” drop down, and then select your desired color scheme. 
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You will then be prompted to verify the range of cells in the table and that your table has a header row (e.g. Name, W, L, ERA, etc.).  
Check “My table has headers”.  Click OK. 

 

3.  Because we’ll later be pulling these pitcher projections into other worksheets, it will help us greatly if the Fangraphs player ID is the first 
column of the table (you can use the VLOOKUP formula if the player ID is in the first column, otherwise you’re stuck using more 
difficult and/or multiple formulas).  Right-click on the top of the Fangraphs player ID column (should be column X in the Steamer 
Pitchers projections). 

 

Now right-click on the top of the player name column (column header “A”) and select “Insert Cut Cells”.  When you’re done, you should 
have the “playerid” column first and “Name” second. 
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4.  Before we finalize this table, we must give it a name.  Go to the “Formulas” tab on the Excel ribbon and click on the “Name Manager” 
button. 

 

5.  You should see one generic item in the list, like “Table4″.  Select this table from the list and click on the “Edit…” button. 

 

Give the table a meaningful name, like “STEAMER_P” to indicate these are the Steamer Pitcher projections.  Click “OK” to close the 
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“Edit Name” menu.  Then click “Close” to exit the “Name Manager”. 

 

6.  We now have two tables containing pitching information that we will pull from, PLAYERIDMAP (information about player name, 
position, team) and STEAMER_P (Steamer pitching projections).  We are going to pull from these two tables into a new tab where we 
will calculate the pitcher rankings. 

7.  Right click on the “Hitter Ranks” tab and select the option to “Insert…”.  Choose the “Worksheet” option and click “OK”.   
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8.  Right click on the new sheet tab and choose to “Rename”.  Call this sheet “Pitcher Ranks”. 

 

9.  We want the first column of this new sheet to contain the Baseball Reference player ID (e.g. “strasst01″ for Stephen Strasburg).  The 
PLAYERIDMAP sheet has a list of all fantasy-relevant players (for standard rotisserie leagues, at least).  However, this sheet contains 
hitters also.  Because this sheet is an Excel table, it’s easy to filter out those hitters.  Click on the drop down arrow on the “POS” column.  
You’ll be presented with a list of all the positions.  Uncheck any position player and check the “RP”, “SP”, “P” values.  Click OK to 
apply. 
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10.  Starting with the first player and ending with the last, click and drag within the “IDPLAYER” column (first column) and select all 
players.  Only select from this first column. 

 

11.  Copy this selected data.   Return to the “Pitcher Ranks” sheet.  Type “PLAYERID” into cell A1 (to label the column).  Then paste the 
data into cell A2. 
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12.  Because this is a new sheet, we need to convert it to an Excel table.  We will essentially repeat step 2 above, but for this different 
worksheet.  Click once to select any player ID.  Then locate the “Home” tab in the Excel menu system (“the ribbon”).  Click once on the 
“Format as Table” drop down, and then select your desired color scheme. 

 

13.  You will then be prompted to verify the range of cells in the table and that your table has a header row (which we added in step 11).  
Check “My table has headers”.  Click OK. 

 

14.  Repeat steps 4-6 above to give the table a more meaningful name.  In my example, Excel defaulted the table name to “Table5″.  I 
renamed mine to be “MYRANKS_P” (to indicate pitcher ranks). 
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15.  Now let’s start pulling data from the other tabs.  If you need more explanation of the formulas used, refer to Part 3 of the series.  Use the 
VLOOKUP formula to pull  LASTNAME, FIRSTNAME, TEAM, POS, and IDFANGRAPHS from the PLAYERIDMAP table.   

To get you started, type “LNAME” into cell B1.  The example formula to add in cell B2 in order to pull LASTNAME is shown here: 

=VLOOKUP([@PLAYERID],PLAYERIDMAP,COLUMN(PLAYERIDMAP[LASTNAME]),FALSE) 

 

Create column headers for first name, team, position, and Fangraphs ID.  Add the bolded formula above to each column.  You will only 
need to change the “[LASTNAME]” component to “[FIRSTNAME]”, “[TEAM]”,“[POS]”,and “[IDFANGRAPHS]”. 

16.  We’ve now pulled all the relevant information from PLAYERIDMAP and can now begin pulling in pitcher projections.  Add columns 
and VLOOKUP formulas to pull wins (W), games started (GS), saves (SV), innings pitched (IP), hits allowed (H), earned runs allowed 
(ER), home runs allowed (HR), strikeouts (SO), walks (BB), and fielding independent pitching (FIP).  

There will be some tweaks to the VLOOKUP formula we used earlier.  First, the Steamer projections use Fangraphs ID numbers.  So we 
will be using the IDFANGRAPHS column as the Lookup_value.  Second, we must specify to pull from the Steamer Pitchers projections 
(STEAMER_P table name).  And finally, the COLUMN formula will change to determine what statistic to pull. 
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=VLOOKUP([@IDFRANGRAPHS],STEAMER_P,COLUMN(STEAMER_P[W]),FALSE) 

The example formula above is for wins (“[W]”).  Go through and add columns to also pull in “[GS]”, “[SV]”, “[IP]”, “[H]”, “[ER]”, 
“[HR]”, “[SO]”, “[BB]”, and “[FIP]”. 

17.  I don’t pull ERA or WHIP because they are rate statistics.  I prefer to recalculate them with a formula after the underlying statistics have 
been pulled.  That way, if I change the projections for a player, the ERA and WHIP will automatically recalculate with the updated 
projections.  I make an exception for FIP.  My guess is that FIP is the underlying projection that Steamer would base the ERA projection 
on.  I’m not doing my own projection of FIP, so I’ll leave it as is.  To add ERA, type “ERA” in as a column header.  Then enter the 
formula to calculate ERA “=[@ER] * 9 / [@IP]. 

 

To add WHIP, type “WHIP” in as a column header.  Then enter the formula to calculate WHIP “=([@BB]+[@H])/[@IP]”. 

 

18.  Most statistics don’t need formatting, but ERA and WHIP will.  Click and drag on the column headers for ERA and WHIP(“Q” and “R”, 
likely) to select them.   

 

Then on the Home tab of the ribbon, click on the comma number format. 
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19.  We’ve now successfully combined player information and projected stats into one table. 

 

WRAP UP 

Most of the hard work is done at this point.  We now have long lists of players and their projected stats.  But how do we rank them? 

In the next part of the series we’ll discuss a method of evaluating a player’s projected stats and determining a ranking based upon those stats. 

LINK TO DOWNLOAD EXAMPLE FILE 

SFBB Rankings – Part 4.xlsx 

QUESTIONS? 

Questions about Part 4?  Post them here. 

http://www.smartfantasybaseball.com/wp-content/uploads/2013/03/SFBB-Rankings-Part-4.xlsx
http://www.smartfantasybaseball.com/2013/03/create-your-own-fantasy-baseball-rankings-part-4-pitcher-rankings/#comment-152
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PART 5 – UNDERSTANDING STANDINGS GAIN POINTS 
INTRODUCTION 

In this fifth part of the series we will discuss the concept of Standings Gain Points (SGP), a method of evaluating and ranking players.  At the 
end of this part, we will have some primitive rankings in place.  But we have quite a few concepts to go over before we jump into Excel. 

THE DIFFICULTY IN RANKING PLAYERS 

Which player is worth more and should be ranked higher? 

• Player A – .280, 65R, 30HR, 95RBI, 0SB 

• Player B – .265, 100R, 10HR, 55RBI, 40SB 

Or how about this? 

• Player A – .280, 65R, 30HR, 95RBI, 0SB 

• Player C – 5W, 40SV, 75SO, 2.50ERA, 1.10 WHIP 

How do you rank different types of players (speed/average vs. power/RBI)?  Or even more difficult, how do you evaluate the worth of a hitter 
against the worth of a pitcher?  Enter the concept of Standings Gain Points. 

STANDINGS GAIN POINTS – MY INTERPRETATION 

The end goal of rotisserie fantasy baseball is to accumulate the most points in the standings.  The Standings Gain Points approach to valuing 
players is to convert a player’s statistics into the number of rotisserie points those statistics are worth.   

Let’s use some example statistics from a real 12-team 5×5 rotisserie league to illustrate: 
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POS HR RBI W ERA 

1 291 1,054 108 3.359 

2 287 1,027 107 3.365 

3 281 1,017 93 3.477 

4 274 1,003 92 3.678 

5 272 998 88 3.815 

6 267 973 88 3.857 

7 263 968 84 3.946 

8 261 965 82 4.096 

9 244 945 82 4.097 

10 239 921 81 4.177 

11 234 920 81 4.284 

12 191 792 78 4.361 

The first place finisher in Home Runs accumulated 291 HR for the year.  The last place finisher accumulated 191.  That leaves a spread of 
100 HR from the first place team to the last place team (291 – 191 = 100). 

In this 12-team league, there are 11 standings points that can be gained (even the last place team gets 1 point, the first place team 12, so 11 
points can be gained). 
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This means that it takes roughly 9.1 home runs to move up one position in the home run standings (100 HR gap / 11 positions to move). Pick 
just about any position in the home run list, add 9 HR, and you can see that you do move up about 1 spot. 

Running the numbers for the other statistics, we get: 

RBI:  (1,054 – 792) / 11 = 23.82 

W:  (108 – 78) / 11 = 2.73 

ERA:  (3.359 – 4.361) / 11 = -0.091 

DO I HAVE TO CALCULATE THESE MYSELF? 

You could.  It would probably be best to calculate using your league’s specific history.  Or Razzball has calculations from their average 12-
team fantasy league you can review here (or if you really want to rub geek juice all over your body, check this out).  For what it’s worth, I’ve 
been calculating this for my long-time standard mixed 12-team roto league ($260 auction budget, 14 hitters, 9 pitchers) and the results come 
amazingly close to Razzball’s findings: 

Category Razzball (based on 48 12-team 
leagues in 2012) 

My League (based 8 year 
history, 12-teams) 

R 24.6 25.1 

HR 10.4 10.0 

RBI 24.6 26.0 

SB 9.4 10.3 

AVG .0024 .0020 

W 3.03 3.39 

http://razzball.com/stats-needed-to-win-your-fantasy-baseball-league/
https://docs.google.com/spreadsheet/ccc?key=0An3I_TiueBsydEQ4LXpkYTFITU0yTF8tZGEzZU9CZWc#gid=17
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Category Razzball (based on 48 12-team 
leagues in 2012) 

My League (based 8 year 
history, 12-teams) 

SV 9.95 6.30 

SO 39.3 33.9 

ERA -.076 -.100 

WHIP -.015 -.016 

 

CALCULATING SGP FOR A PLAYER – COUNTING STATS 

Steamer’s Projections predict 26 HR for Mike Trout in 2013.  If I conclude to use Razzball’s calculation that every 10.4 HR is equal to a one 
position increase in the rotisserie standings, then Mike Trout’s HR equal a 2.5 point increase in the standings (26/10.4 = 2.5).   Or 2.5 
Standings Gain Points. 

Other statistics similar to HR, where players simply accumulate or “count” the statistics one-by-one are referred to as “counting stats”.  These 
are easy to calculate SGP for.  Simply take the number of the counting stat (Trout’s 42 projected SB) and divide by the quantity of the stat 
required to move up one standings point (per Razzball, 9.4 SB to move up one position).  So Trout’s 42 SB are worth 4.46 SGPs (42 / 9.4). 

For pitchers, wins, saves, and strike outs are also “counting stats” and allow for easy calculation of SGP. 

But what about batting average, ERA, and WHIP? 

CALCULATING SGP FOR A PLAYER – RATIO STATS 

AVG, ERA, and WHIP are referred to as “ratio stats”.  The calculation of SGP for these is a bit more involved.  Think about this scenario… 

Mike Trout is projected for 619 at bats.  He’s projected to hit .297 (184H/619AB). 
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Troy Tulowitzki is projected for 434 at bats.  He’s projected to hit .300 (130H/434AB). 

Which player will have a bigger impact on your team’s batting average?  Does the fact that Trout will hit .297 over nearly 200 more at bats 
make him more valuable?  Or does Tulowitzki’s .300 average make him the better “batting average contributor”? 

Let’s run the numbers.  If we assume a league of 12 teams and 14 hitters on each team (adjust for your roster size), that is 168 players (12 * 
14).  In the Steamer projections, the top 168 major leaguers are projected for an average of about 509 at bats per player. 

This means the average team in this fantasy league will have approximately 7,126 at bats (14 players * 509 at bats).  According to Razzball, 
the average rotisserie batting average in 12-team leagues was .267.  This means the average team had approximately 1,902 hits (7,126 * .267).  
And the average player had 136 hits (1,902 team hits / 14 players). 

To find the impact of Trout we need to remove one “average” player from the team and then add in Trout’s projections.  We can do the same 
for Tulowitzki. 

13 “average” players * 509 at bats = 6,617 

13 “average” players * 136 hits = 1,768 

Add Trout’s projections (184 Trout hits + 1,768 other hits) / (619 Trout ABs + 6,617 other ABs) = .26976 

Add Tulowitzki’s projections:  (130 Tulowitzki hits + 1,768 other hits) / (434 Tulowitzki ABs + 6,617 other ABs) = .26918 

So despite his lower batting average, Trout’s impact on the team batting average is greater than Tulowitzki’s, due to the number of at bats.  
It’s this weighting we have to take into account for “ratio stats”. 

To finish the example, if the team batting average with Trout is .26976 and the team batting average without Trout is .267, he increases the 
team average .00276 (.26976 – .267).  Looking above again, Razzball calculates that a .0024 increase in BA equals one point in the rotisserie 
standings.  This makes Trout’s BA worth 1.15 SGP (.00276 / .0024). 

Enough concepts.  Let’s rank some flippin’ players 

 

. 

http://razzball.com/stats-needed-to-win-your-fantasy-baseball-league/


The Smart Guide To Creating Your Own Fantasy Baseball Rankings    Tanner Bell 

Page 48  
  

STEP-BY-STEP INSTRUCTIONS 

These instructions will help convert the statistics in our rankings spreadsheet into Standings Gain Points so we can begin to rank players. 

Step Description 
1.  Open your existing rankings spreadsheet (if you don’t have one started, you can download from Part 4 here). 

2.  Add five new columns to the “Hitter Ranks” sheet.  Do this by typing in column headers beginning in the first empty column to the right 
of your existing data.  Name the new columns RSGP, HRSGP, RBISGP, SBSGP, AVGSGP (as in “Runs Standings Gain Points”, 
“Home Runs Standings Gain Points”, etc.). 

 

Because we have this sheet formatted as an Excel table, as soon as the column header is added, the entire column will be added to the 
table. 

3.  After you’ve added these five columns, add a sixth column named “TTLSGP”.  This will calculate the total SGP across the five hitting 
categories. 

4.  Add five new columns to the “Pitcher Ranks” sheet.  Do this by typing in column headers beginning in the first empty column to the 
right of your existing data.  Name the new columns WSGP, SVSGP, SOSGP, ERASGP, WHIPSGP (as in “Wins Standings Gain 
Points”, “Saves Standings Gain Points”, etc.). 

 

5.  After you’ve added these five columns, add a sixth column named “TTLSGP”.  This will calculate the total SGP across the five pitching 
categories. 

6.  Let’s assume a 12-team league and that Razzball’s estimate of the statistics needed to move up one spot are accurate.  The formulas to 
add to the Hitter Ranks columns added above in step 2 are: 

http://www.smartfantasybaseball.com/wp-content/uploads/2013/03/SFBB-Rankings-Part-4.xlsx
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Column Excel Formula 

RSGP =[@R]/24.6 

HRSGP =[@HR]/10.4 

RBISGP =[@RBI]/24.6 

SBSGP =[@SB]/9.4 

AVGSGP =(([@H]+1768)/([@AB]+6617)-0.267)/0.0024 

TTLSGP =[@RSGP]+[@HRSGP]+[@RBISGP]+[@SBSGP]+[@AVGSGP] 
 

7.  The formulas to add to the Pitcher Ranks columns added above in step 3 are: 

Column Excel Formula 

WSGP =[@W]/3.03 

SVSGP =[@SV]/9.95 

SOSGP =[@SO]/39.3 

ERASGP =((475+[@ER])*9/(1192 + [@IP])-3.59)/-0.076 

WHIPSGP* =((1466+[@H]+[@BB])/(1192+[@IP])-1.23)/-0.015 

TTLSGP* =[@WSGP]+[@SVSGP]+[@SOSGP]+[@ERASGP]+[@WHIPSGP] 
 

8.  You can now sort both the Hitter Ranks and Pitcher Ranks by the new TTLSGP column to see the “best” players.  To sort, click the 



The Smart Guide To Creating Your Own Fantasy Baseball Rankings    Tanner Bell 

Page 50  
  

downward pointing arrow on the TTLSGP column.  Then select “Sort Largest to Smallest”.  Hit OK to perform the sort. 

 

9.  As the calculations stand right now (there are some additional changes to be made in Part 6 of the series), the top ten pitchers are: 

 

 

WRAP UP 

The rankings look pretty good, eh?  They’re mostly consistent with the consensus rankings you can find anywhere on the web for the 2013 
season.  But they can also unearth some hidden gems.  Cliff Lee as the projected #1 pitcher?  Pretty interesting when he’s being drafted #35 in 
ESPN drafts (at the time this article is being written). 

In the next part of the series we investigate the theories of “replacement level players” and “position scarcity”.  We will adjust our 
calculations for these theories in an effort to better fine tune the rankings. 
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I’ve included some more in depth discussion about standings gain points below.  It’s not necessary to read, but I feel the need to acknowledge 
some weaknesses in the SGP approach. 

LINK TO DOWNLOAD EXAMPLE FILE 

SFBB Rankings – Part 5.xlsx 

QUESTIONS? 

Questions about Part 5?  Post them here. 

DISCLAIMER 

I prefaced this SGP discussion by saying this is “my interpretation”.  I do this because I’m not a mathematician.  And I’m certain that there 
are some mathematical errors or logic flaws in my presentation.  But in general, I believe the approach is sound.  I am aware that there is 
dispute in the theory behind standings gain points (some very respected minds think it makes no mathematical sense).  Here are my thoughts 
on the dispute: 

• When I look at what these SGP calculations kick out, they pass the eye test.  They look right.  They make sense.   

• In the article link above, Todd Zola points out that the main flaw in SGP versus more mathematically sound approaches is that stolen 
bases are undervalued by SGP.  Sluggers that steal very little are overvalued by SGP. 

• I DO NOT SUGGEST you use SGP as a means of constructing a team.  I only use SGP as a vehicle to rank players.  Said another 
way, I don’t build a team thinking I need to draft players that will add up to 12 SGPs in a category.  I only use the rankings as a 
barometer of how to value certain players. 

• Drafting solely based upon Total SGPs is not wise, as it can lead to an unbalanced team.  I prefer to draft with “What it takes to win 
your league?” in mind.  I know that it takes about 200 SB to win the category.  So I draft players to reach 200 SB.  Not 12 SB SGPs. 

• I don’t believe in a purely quantitative and statistical approach to drafting players either.  There are a lot of qualitative factors that 
projections, rankings, SGP, or any other valuation method cannot account for.  Age, potential, likelihood of injury, competition for 
playing time, contract situation, and other factors that need to be taken into account.  I create rankings and then adjust those rankings 
for this multitude of other factors. 

http://www.smartfantasybaseball.com/wp-content/uploads/2013/03/SFBB-Rankings-Part-5.xlsx
http://www.smartfantasybaseball.com/2013/03/create-your-own-fantasy-baseball-rankings-part-5-understanding-standings-gain-points/#comment-153
http://www.mastersball.com/products/SGP%20Theory%202010.pdf
http://www.smartfantasybaseball.com/2013/01/what-it-takes-to-win/
http://www.smartfantasybaseball.com/2013/01/what-it-takes-to-win/
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With all this in mind.  I’m fine with SGP being an imperfect system.  Part of being “smart” is knowing when good enough is good enough. 

*NOTE ABOUT PITCHING RATE CALCULATIONS 

My approach to calculating SGPs for pitching rate categories is based on the following assumptions: 

• 12-team league * 9 pitching spots = 108 pitchers rostered 

• To calculate a baseline for the rate statistics, I perform a rough exercise to approximate the 108 pitchers most likely to be rostered.  I 
include the 108 pitchers with the highest strikeout numbers and with a projected ERA below 4.20. 

• The top 108 strike out pitchers with an ERA below 4.20 in the Steamer projections have an average of 149 IP. 

• This means an 8 pitcher staff has a total of 1,192 IP 

• According to Razzball, the average rotisserie team in a 12-team league had an ERA of 3.59 and WHIP of 1.23  

• To have an ERA of 3.59 on 1,192 IP assumes 475 ER allowed 

• To have a WHIP of 1.23 on 1,192 IP assumes 1,466 BB and H allowed (BB+H) 

• This makes the ERA formula = ((475 ER + pitcher’s projected ER)*9/(1,192 IP + pitcher’s projected IP)-3.59)/-0.076 

• This makes the WHIP formula = ((1,466 H and BB + pitcher’s projected BB + pitcher’s projected H)/(1,192 IP + pitcher’s projected 
IP)-1.23)/-0.015 

 

 

 

 

 

http://razzball.com/stats-needed-to-win-your-fantasy-baseball-league/
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PART 6 – ACCOUNTING FOR REPLACEMENT LEVEL AND POSITION SCARCITY 
INTRODUCTION 

In this sixth part of the series we will discuss the concept of replacement level players and calculating for position scarcity. 

REPLACEMENT LEVEL PLAYERS 

Mike Trout is projected for 114 R, 26 HR, and 83 RBI.  Those numbers are gaudy.  But should he get “credit” for all those statistics if I can 
go out the day after the draft and pick up a player on the free agent list that is projected for 50 R, 15 HR, and 55 RBI? 

This is the concept of replacement level.  If player X is projected for 26 HR and there are several free agents that will hit 15 HR, the true 
value of player X is in his 11 additional HR (26 – 15). 

So when calculating a player’s SGP, you should not perform the calculation on the “gross” or total number of HRs.  Rather, you should 
calculate SGP with the amount of HR over a replacement level player (a free agent). 

DETERMINING REPLACEMENT LEVEL 

Assuming a 12-team league with 14 hitters (two C, 1B, 2B, SS, MI, 3B, CI, five OF, DH), 168 offensive players will be drafted (you can add 
more to adjust for bench players).  So the 169th player is “replacement level”, right? 

Arguably this is true.  But let’s fine tune this a little more.  In a 12-team league where each team must start two catchers, the 25th best catcher 
is the “replacement level catcher”. 

If the league requires one 2B, one SS, and one Middle Infielder, then 36 combined 2B and SS will be drafted.  We can assume this will be 
comprised of 18 2B and 18 SS, and the 19th best of each position will be the “replacement level”. 

Likewise, you might expect 18 1B, 18 3B, and 60 OFs to be drafted.  But given that these positions typically produce better offensive 
statistics than 2B and SS, 1B and OF tend to be slotted into the UTIL/DH spots.  This can push the 1B up to 24 selected players and the OF up 
to 66 selected players (with the 25th 1B being “replacement level” and the 67th OF being “replacement level”.   

Let’s look at some projected statistics for Jason Heyward and Robinson Cano (please note the tables below don’t foot due to rounding) : 
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Category Heyward Cano 

R SGP 3.82 3.58 

HR SGP 2.60 2.40 

RBI SGP 3.62 3.98 

SB SGP 1.38 0.32 

AVG SGP 0.12 0.96 

TTL SGP 11.54 11.25 

 

On the surface, the two are near equals, with Heyward holding a slight overall edge in SGP.  But let’s now compare each to a replacement 
level player at their position.  In my rankings spreadsheet, the 61st ranked OF is Ryan Ludwick. 

 

Category Heyward Ludwick Heyward over Ludwick 

R SGP 3.82 2.32  1.50 

HR SGP 2.60 1.92  0.68 

RBI SGP 3.62 2.72  0.90 

SB SGP 1.38 0.11  1.27 
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Category Heyward Ludwick Heyward over Ludwick 

AVG SGP 0.12 -0.14  0.26 

TTL SGP 11.54 6.93  4.61 

 

In my rankings spreadsheet, the 19th best 2B is Gordon Beckham. 

Category Cano Beckham Cano over Beckham 

R SGP 3.58 2.20  1.38 

HR SGP 2.40 1.25  1.15 

RBI SGP 3.98 2.07  1.91 

SB SGP 0.32 0.53  -0.21 

AVG SGP 0.96 -0.35  1.31 

TTL SGP 11.25 5.67  5.54 

So despite a higher gross SGP (11.54 vs. 11.25), Heyward comes out as less valuable when we adjust for replacement level players.  In fact, 
Cano moves to nearly one whole SGP of an advantage over Heyward (5.54 vs. 4.61). 

As you can see in this example, ADJUSTING GROSS SGP FOR A PLAYER BY BACKING OUT THE VALUE OF A 
REPLACEMENT LEVEL PLAYER AT THE SAME POSITION ADJUSTS THE RANKINGS FOR POSITION SCARCITY. 
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STEP-BY-STEP INSTRUCTIONS 

Step Description 
1.  We first need to add a new tab to our spreadsheet.  Click once on the “RANKINGS=>” tab.  Press and hold the SHIFT key.  Push and 

release your F11 key.  This will add a new tab. 

 

2.  Right-click on the new sheet and select “Rename”.  Name the sheet “Replacement Level”. 

 

3.  Begin to fill out the framework of a table by keying in the following: 
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4.  Click and drag with your mouse to select the area of the table you have started: 

 

5.  On the “Home” tab, select the option to “Format as Table” and choose your desired color scheme.  Specify that your table has headers 
when prompted. 
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6.  Click on the “Formulas” tab and select “Name Manager”. 

 

7.  In the ensuing menu, select the unnamed table (which should relate to the Replacement Level tab we just created).  Chose the “Edit…” 
option and provide a new name for the table. 
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8.  Give the table a name (e.g. “ReplacementLevel_H”).  Hit OK to accept the changes. 

 

9.  Return to the “Hitter Ranks” tab.  Use the drop down arrow on the “TTLSGP” column to ensure it is sorted in descending order (largest 
to smallest). 
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10.  Click on the downward pointing arrow on the “POS” column.  Clear all the position check boxes and select only “C”.  Click “OK” to 
accept this filter. 
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11.  Use your league settings to develop an approximation of how many catchers will likely be drafted.  For example, in a 12-
team league in which each team starts two catchers, there likely won’t be any catchers starting at the DH/UTIL spot.  This 
means that 24 catchers will be drafted and the 25th catcher represents replacement level.   

I believe that identifying one specific player as “replacement level” can be misleading and that it is best to develop a 
“composite” of the replacement level player.  For example, what if the 25th catcher happens to steal a lot of bases and all 
his value comes from this stat.  It would be misleading to compare all the other catchers to this player.  

To calculate this approximate replacement player I suggest creating an average of five players.  The average will be of the 
last draftable player and the two players above him and the two players below him.  Sticking with our example that 24 
catchers will be drafted, I will use catchers #22, #23, #24, #25, and #26. 

Any easy way to figure out who these catchers are is to choose a specific column, click on the value for the first player in 
the column, and then click and drag to select more players (you can see an image of this to the right, make sure you are 
highlighting only one column). 

As you continue to select more players, watch the “Count:” field on the Excel status bar.   

 

12.  In looking at the 22nd – 26th best catchers, I see a rough average of 1.39 SGPs in R, 0.87 in HR, 1.41 in RBI, 0.13 in SB, and -0.35 in 
AVG. 

 

Note that if you select the RSGP information for catchers #22-#26 as shown above, Excel will display the average on the status bar in the 
lower right hand corner of the program. 
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13.  Enter these averages into the Catcher row on the “Replacement Level” tab. 

 

 

14.  Repeat steps 10 – 13 for each position.   

If your league starts Corner Infielders and Middle Infielders, you can likely assume that will break down into an even split between 1B & 
3B and 2B & SS.  For example, in a 12-team league with a CI position, a total of 36 1B or 3B will be drafted (12 1B, 12 3B, and 12 CI).  
I usually assume this will break down to18 1B and 18 3B.  This won’t be exact, but splitting hairs about this will not result in much of a 
benefit to your rankings.   

You must perform a similar adjustment for the DH/UTIL spot in your league.  Again, assuming a 12-team league, we must now adjust 
replacement level by 12 more players.  I generally assume this will result in 6 more OF being drafted and 6 more 1B, because 1B and OF 
are generally the most productive positions.  This means that I assume 24 1B will be drafted (12 to play 1B, 6 to play CI, and 6 to play 
DH/UTIL) and 66 OF (60 to play OF (5 * 12-teams), 6 to play DH/UTIL). 

It is important to keep in mind that these numbers are highly dependent upon two things that will cause the numbers I present below to 
differ from what you will see as you work with your own spreadsheet: 

• The underlying projections used 
• Your league settings 

The projections you use will surely be different from those I used to create this guide.  For one, I created this guide using the 2013 
Steamer projections.  You will be using some projection set you obtained after 2013.  The projections you use determine the statistics of 
the replacement level player.  So your replacement level player will not be the same as mine. 
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Further, your league settings may be different.  I am assuming a 12-team league starting 2 catchers.  If you have a 10-team league or if 
your league starts only one catcher, your definition of who the replacement level player is will be different.   

With those caveats in mind, here are the approximations I calculated using the 2013 Steamer projections for replacement level players 
assuming a 12-team league starting 14 hitters, 9 pitchers, and no bench spots: 

 

Note, the player pool for “DH” only hitters, like David Ortiz, is very small.  Too small to get a meaningful determination about 
replacement level.  I make the assumption that 1B is the best approximation of replacement level for players only eligible at DH . . 

15.  Now that we’ve determined what “replacement level” is, we need to adjust our SGP calculations to back out the statistics of a 
replacement level player.  The trick here is that the Hitter Ranks sheet has players of all positions and the Replacement Level sheet has a 
table containing the corresponding replacement level statistics for each position.  To subtract out the replacement level statistics for each 
position, we need to adjust this formula to go into the “Replacement Level” tab, find the player’s position, then retrieve the amount to 
subtract for that specific position.   

Recall the VLOOKUP formula can be used to search in another table for a specific value (look in the replacement level information and 
find a specific position.  You’ll remember the original formula for RSGP was =[@R]/24.6 

 

Subtracting replacement level data from this using VLOOKUP yields this formula: 

=[@R]/24.6-VLOOKUP([@POS],ReplacementLevel_H, COLUMN(ReplacementLevel_H[R]),FALSE) 
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16.  Add VLOOKUP formulas for the remaining hitting categories.  In the formulas below, the non-bolded component was previously added 
to your spreadsheet.  The bolded information should be added now. 

CATEGORY FORMULA 

R =[@R]/24.6-VLOOKUP([@POS], ReplacementLevel_H, COLUMN(ReplacementLevel_H[R]), 
FALSE) 

HR =[@HR]/10.4-VLOOKUP([@POS], ReplacementLevel_H, 
COLUMN(ReplacementLevel_H[HR]), FALSE) 

RBI =[@RBI]/24.6-VLOOKUP([@POS], ReplacementLevel_H, 
COLUMN(ReplacementLevel_H[RBI]), FALSE) 

SB =[@SB]/9.4-VLOOKUP([@POS], ReplacementLevel_H, COLUMN(ReplacementLevel_H[SB]), 
FALSE) 

AVG =(([@H]+1768)/([@AB]+6617)-0.267)/0.0024 – VLOOKUP([@POS], ReplacementLevel_H, 
COLUMN(ReplacementLevel_H[AVG]), FALSE) 

 

17.  Perform steps 3-8 in order to create a pitchers replacement level table on the Replacement Level tab.  This will be a much simpler 
exercise as there is only one position for pitchers.  Name the table ReplacementLevel_P. 

18.  Perform the equivalent of steps 11 - 13 for pitchers.  In a 12-team league that rosters 9 pitchers, 108 starting pitchers will be drafted, 
leaving players 106 through 110 as my “composite replacement level” pitcher.  Looking at pitchers 106 – 110, here are the replacement 
level average SGPs I come up with for pitchers: 

POS W SV SO ERA WHIP TTL 

P  3.23  0  2.68  -0.85  -0.88  4.18 
 

19.  Enter the averages into your newly created ReplacementLevel_P table. 
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20.  To subtract out the replacement level statistics for pitchers, we need to adjust the formulas to go into the “Replacement Level” tab, find 
the pitcher replacement level statistics, then retrieve the amount to subtract.  Recall the VLOOKUP formula can be used to search in 
another table for a specific value (look in the replacement level information and find a specific position.  You’ll remember the original 
formula for WSGP was =[@W]/3.03. 

 

Subtracting replacement level data from this using VLOOKUP yields this formula. 

=[@W]/3.03-VLOOKUP([@POS],ReplacementLevel_P, COLUMN(ReplacementLevel_P[W]), FALSE) 

21.  Add VLOOKUP formulas for the remaining pitching categories.  Note, I assume all starting closers are taken in 12-team leagues; 
therefore, there is no reason to make a replacement level adjustment. 

CATEGORY FORMULA 

W =[@W]/3.03-VLOOKUP([@POS], ReplacementLevel_P, 
COLUMN(ReplacementLevel_P[W]), FALSE) 

SV =[@SV]/9.95 

SO =[@SO]/39.3-VLOOKUP([@POS], ReplacementLevel_P, 
COLUMN(ReplacementLevel_P[SO]), FALSE) 

 

ERA =((475+[@ER])*9/(1192+[@IP])-3.59)/-0.076-VLOOKUP([@POS], 
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ReplacementLevel_P, COLUMN(ReplacementLevel_P[ERA]), FALSE) 

WHIP =((1466+[@BB]+[@H])/(1192+[@IP])-1.23)/-0.015-VLOOKUP([@POS], 
ReplacementLevel_P, COLUMN(ReplacementLevel_P[WHIP]), FALSE) 

 

22.  It’s possible that some players would rise or fall in the total SGP ranking after these changes.  Sort the hitter and pitcher ranks from 
highest value to lowest value again using the drop down arrow over the “TTLSGP” column. 

 

23.  It is extremely important to perform a reasonableness check when you’re done with this exercise.  If you have done everything correctly, 
when you’re done, you should see that the number of players with positive SGPs should be approximately equal to the number of players 
your league will draft.   

For example, I have been assuming a 12-team league where each team drafts 14 hitters.  This means 168 hitters will be drafted.  If I look 
in my “Hitter Ranks” tab, I should see that the players right around the #168 mark will have very close to 0.00 for TTLSGP. 

 

Row #169 represents the 168th player (accounting for the header row in the sheet).  And you can see everyone here is about at 0.00 SGP 

If you find that you have too many players above 0.00 TTLSGP, you must raise your replacement level calculations.  If the replacement 
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level averages are higher, fewer players will come out above 0.00.  If you have too few players above 0.00 TTLSGP, you must lower 
your replacement level calculations.  If replacement levels are lower, more players will come out above 0.00. 

24.  You did it!  You now have completed hitter and pitcher rankings based upon reliable projection data that also takes into account and 
adjusts for position scarcity. 

WRAP UP 

In my opinion, you have just completed the most comprehensive guide to creating your own fantasy baseball rankings available.  You have 
just created a very powerful and flexible rankings spreadsheet.  You can easily adjust the projection data and have your changes instantly flow 
through the calculations and update the rankings accordingly.  Are you ready for your next challenge?  How about calculating your own 
projections. 

LINK TO DOWNLOAD EXAMPLE FILE 

SFBB Rankings – Part 6.xlsx 

QUESTIONS? 

Questions about Part 6?  Post them here. 

PARTS 7 THROUGH 10 – CONVERTING SGP RANKINGS TO DOLLAR VALUES 
The next steps in finalizing the rankings process are to convert the SGPs for players into dollar values.  Dollar values are 
especially important for auction drafts, but are also very helpful even for snake draft formats.  Using dollar values makes hitters 
and pitchers directly comparable to one another.  Comparing the SGP for a hitter to a pitcher without converting to a dollar 
value can be misleading because it does not take into account the hitter/pitcher allocation.  Part 10 even takes you through 
calculating price inflation for keepers and in-draft inflation. 

Click here to find out how you can get similar step-by-step instructions for converting your rankings into dollar values.   

 

http://www.smartfantasybaseball.com/projecting-x-podhorzer-how-to-create-your-own-fantasy-baseball-projections/
http://www.smartfantasybaseball.com/projecting-x-podhorzer-how-to-create-your-own-fantasy-baseball-projections/
http://www.smartfantasybaseball.com/wp-content/uploads/2013/03/SFBB-Rankings-Part-6.xlsx
http://www.smartfantasybaseball.com/2013/03/create-your-own-fantasy-baseball-rankings-part-6-accounting-for-replacement-level-and-position-scarcity/#comments
http://www.smartfantasybaseball.com/2014/02/what-is-the-ideal-spending-allocation-between-pitchers-and-hitters/
http://www.smartfantasybaseball.com/e-book-using-standings-gain-points-to-rank-players-and-create-dollar-values/
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